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ABSTRACT

TIDA-010224 is designed as a reference for low-power Wi-Fi® cameras capable of operating from battery 
supplies. In order to extend battery lifetime as much as possible, most sockets are chosen to have a shutdown 
current in the nA range (as shown in Figure 1-1) and the TPS63802 high-efficiency buck-boost is used. In order 
to better understand more easily evaluate TIDA-010224, this application note describes a few additional use 
cases, how to set up the compiler environment if code changes are needed, how to update the firmware of 
CC3235 and OA7000, and how to test these use cases.

Figure 1-1. TIDA-010224 Hardware Design Structure
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1 Introduction
Below are additional test cases demonstrating the design's low power consumption. In some cases build of 
material (BOM) and firmware changes are required.

Adding test cases:

• Testing current in hibernate mode
• Testing current in LPDS mode
• Testing average current under Intermittently connecting mode (sending 100 data to server)
• Testing average current under always connecting mode (sending 100 data to server)
• Test key step time when startup (via universal asynchronous receiver/transmitter (UART) printing or signal of 

connector)
• Evaluate performance of video and audio

Test case Features:

• The system can be put in wakeup from both Hibernate and LPDS mode via general-purpose input/output 
(GPIO) or real-time clock (RTC).

• The current in hibernate mode is around 20 µA/5 V.
• The current in LPDS mode is around 120 µA/5 V.
• Startup time from hibernate to full running is less than 500 ms.
• Configurable interval time in intermittently connecting mode or always connecting mode
• Configurable stream transferring of only video, video and audio, video and ring

2 Hardware BOM and Firmware Modification
In order to reduce leakage current as much as possible, there are some necessary changes to implement.

• Hardware bill of material (BOM) changes

Table 2-1. Table 1. BOM Changing of TIDA-010224
Change Position Note
Delete CC1352 EVM board In these test cases, no Sub-1 GHz 

connection.

Delete R116, R137, R91, R152, R118, R35-R40, 
R127, R128

Change Net float U4.5 pin

Change Net Exchange resistor on R159 and R160 
position

Make CC3235 can control

• Firmware changes

Table 2-2. Table 2. Firmware Changing of TIDA-010224
Add Function Detail
Hibernate mode • Enter Hibernate mode via UART input '1'.

• Choose which audio from, no audio/from microphone/from ring music after RTSP 
connected.

• Be wakeup by any of UART input.
• If there is not a saved AP list in site, enter provisioning mode after it is in wakeup.
• If there is a saved AP, connect with AP and prepare accepting RTSP connection after 

wakeup.
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Table 2-2. Table 2. Firmware Changing of TIDA-010224 (continued)
Add Function Detail
Intermittently Connected mode • Enter Intermittently mode via UART input '2'.

• Choose which audio from, no audio/from microphone/from ring music after RTSP 
connected.

• Define remote TCP server IP address.
• Define interval wakeup time from hibernate.
• Output 100 data to remote TCP server after wakeup.
• Wakeup by any UART input when it is in hibernate.
• Enter accepting RTSP connection mode after wakeup by GPIO (UART input)

Always Connected with Long Sleep mode/with 
IOT mode

• Enter always connected mode via UART input '3' or ‘4’.
• Define beacon time of connecting with AP.
• Choose which audio from, no audio/from microphone/from ring music after RTSP 

connected.
• Define remote TCP server IP address.
• Define interval time of sending data to TCP server.
• Send out 100 data to remote TCP server after wakeup from LPDS mode by RTC.
• Wakeup by any UART input when it is in LPDS.
• Enter accepting RTSP connection mode after wakeup by GPIO (UART input).

Measure Time of Key action mode • Enter measure time mode via UART input '5’.
• Define remote TCP server IP address.
• Send 10 pages image data to TCP server after triggered by any UART input.
• Print timestamp of key action, same time, output HW signal via CC3235 GPIO_06 pin.

3 Firmware Compiler Environment Setup (if change or evaluate code are needed)

3.1 Hardware and Software Prepared
Device

• TIDA-010224 demo board
• CC3235 Launch EVM
• PC
• 2x microUSB cable

Firmware compiled based on

• Code Composer Studio™ (CCS) Version: 11.1.0.00011
• Simplelink™ CC32xx SDK Version :5.30.00.08
• sysconfig tool Version: 1.11.0
• FreeRTOSv202107.00

3.2 Hardware Connection
1. Short J11.3 and J11.4 with a jumper in order to enable download function via UART.

Figure 3-1. J11 Connector
2. Connect J13 to CC3235EVM board UART pin according to the Connections Between CC32xx LaunchPad™ 

and Wireless Camera Module (J13 Connector) figure in the Design Guide: TIDA-010224 Low-Power 
Wireless Camera Reference Design for Extended Battery Life.

Firmware Compiler Environment Setup (if change or evaluate code are needed) www.ti.com
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3. Connect J5 to CC3235EVM board’s J7(XDS10 OUT) connector with a JTAG cable.

Figure 3-2. PCB Connector
4. Connect the PC to the camera board and the CC3235EVM board with the 2x USB cable. Power on these 

two boards.

3.3 CCS Environment Configuration
1. Unzip FreeRTOS™ package (download from freertos.org) in a folder, and add variable in dialog from CCS-

>Window->Preferences->Code Compose Studio->Build->Variables.

Variable name: FREERTOS_INSTALL_DIR

Value: C:\ti\FreeRTOSv202107.00 (unzip folder address)

Figure 3-3. FreeRTOS Variable Dialog in CCS
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2. Install Simplelink CC32xx SDK and the sysconfig tool (download from TI.com). Refresh product in dialog 
from CCS->Window->Preferences-> Code Compose Studio->Products.

Figure 3-4. Installed Products Dialog in CCS
3. Open Workspace in CCS.

If there is no available workspace when CCS is started, a dialog will pop up to ask to select a directory as 
workspace. Browse to the unzipped CC3235 Firmware folder and click ‘Launch’.

If a workspace in CCS is already opened, browse to the unzipped CC3235 Firmware folder in dialog from 
CCS->File->Switch Workspace->Other, and click ‘Launch’.

Figure 3-5. Launch Project in CCS

Firmware Compiler Environment Setup (if change or evaluate code are needed) www.ti.com
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4 Upgrade Firmware of CC3235 and OA7000

4.1 Prepared Components
Device

• TIDA-010224 demo board
• USB to UART (3.3 V TTL) or CC32xx Launch EVM
• PC
• 5 V microUSB Power and 2x microUSB cable

Software

• Uniflash from TI
• Serial assist tool
• mftfw_tools from Omnivisioin

4.2 Upgrade CC3235 Firmware
1. Make SOP(J11) jumper to short J11.3 and J11.4 as shown in shown in Figure 3-1.
2. Serial port connection:

a. Plug USB2Uart in PC.
b. Connect USB2Uart (TTL) pin to TIDA-010224 board J13.

i. If using the universal USB to 3.3V TTL tool, connect J13.3(TX), J13.5(RX) and J13.9(GND).
ii. If using the CC32xx EVM, connect the pin according to the Connections Between CC32xx 

LaunchPad™ and Wireless Camera Module (J13 Connector) figure in the Design Guide: 
TIDA-010224 Low-Power Wireless Camera Reference Design for Extended Battery Life.

Figure 4-1. J13 Connector
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3. Power up:
a. Connect USB power input of board to PC or USB adapter with microUSB cable.

Figure 4-2. PCB USB/5 V Power Input Connector and SW3 Connector
4. Open Uniflash, select as below.

Figure 4-3. Uniflash Startup Page

a. Input CC3235.

Upgrade Firmware of CC3235 and OA7000 www.ti.com
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b. Select LAUNCHXL-CC3235SF.
c. Click ‘Start Image Creator’ button.

Figure 4-4. Uniflash Image Creator Setting Page 1
d. Click and Create a new project.

Figure 4-5. Uniflash Image Creator Setting Page 2
e. Input project name.
f. Select CC3235SF.
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g. Select Develop mode.

Figure 4-6. Uniflash Image Creator Setting Page 3
h. Click to create.
i. Select ‘Station’.
j. Browse and select ‘WIFI_Current.bin’.
k. Browse and select ‘sp_4.12.0.1_3.7.0.1_3.1.0.26.bin’ to install CC32xx SDK. It is located in 

“\ti\simplelink_cc32xx_sdk_5_30_00_08\tools\cc32xx_tools\servicepack-cc3x35”.
l. Click to connect PC to board.
m. Click ‘Burn’ to create the image and burn.

Figure 4-7. Uniflash Image Creator Setting Page 4
n. Click 'Program image' button.

Upgrade Firmware of CC3235 and OA7000 www.ti.com
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Figure 4-8. Uniflash Image Creator Setting Page 5

4.3 Upgrade OA7000 Firmware
1. Make SW3 jumper to ‘100’.

Figure 4-9. SW3 Boot-Mode Selection
2. Connect the microUSB cable to the PC and camera board.
3. Connect the USB2Uart tool to the PC and camera board serial port as described in Section 4.2.
4. Open the serial assist tool in the PC, and open the COMx port with ‘115200, 8 bit, None parity, 1 Stop bit, 

None handshaking’.
5. Power up camera board via ‘USB power input’.
6. Input ‘1’ for hibernate.
7. Input ‘1’ for only video.
8. Input any to wakeup camera board from hibernate and power on OA7000.

Note
Because OA7000 power is controlled by CC3235, first, you need power on OA7000.
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9. Open MFT.exe in mftfw_tools, select as shown in Figure 4-10.

Figure 4-10. MFT Tool Setting Page 1
10. Double click ‘mftfw’->oa7000s->mftfw.bin in ‘Select mft*.bin’ dialog. Then a new dialog window pops up 

named ‘Select prj_cfg.txt’.
11. Double click ‘prj_cfg.rd7000s.txt’. It returns the main dialog named ‘OA7000 MFTxxxxx’.

Figure 4-11. MFT Tool Setting Page 2
12. In this dialog, it shows ‘Connected’. Click the ‘BURN SINGBIN’ button.
13. Find ‘SINGLE.BIN’ and double click it. bin file burns to OA7000.

Upgrade Firmware of CC3235 and OA7000 www.ti.com
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Figure 4-12. MFT Tool Setting Page 3

5 How to Test Current and Startup Time

5.1 Prepared Components
Device

• TIDA-010224 demo board
• USB to UART (3.3 V TTL) or CC32xx Launch EVM
• WIFI AP
• PC
• Cell Phone
• 5 V microUSB Power and cable
• Current meter or DC analyzer (optional)

Software

• Serial assist tool
• Net assist tool
• Network Stream video player (EasyPlayer for RTSP or something like this)
• SimpleLink Wi-Fi® Starter Pro APK (download from google store or Apple APP store)

5.2 Setup Test Environment
1. Power connection:

a. If testing current, Power on from 5 V DC terminal. If only testing functions, USB power input connector is 
also OK.

2. Serial port connection:
a. Plug USB2Uart in PC.
b. Connect USB2Uart(TTL) pin to TIDA-010224 board J13 as shown in Figure 3-1.

i. If selecting universal USB to 3.3 V TTL tool, connect J13.3(TX), J13.5(RX) and J13.9(GND).
ii. If selecting CC32xx EVM, connect the pin as shown in the Connections Between CC32xx 

LaunchPad™ and Wireless Camera Module (J13 Connector) figure in the Design Guide: 
TIDA-010224 Low-Power Wireless Camera Reference Design for Extended Battery Life.
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3. Setup serial assist tool:
a. Open the related USB2Uart port before the following settings:

i. Baud rate: 115200
ii. Data bits: 8
iii. Parity: none
iv. Stop bit: 1
v. Handshaking: none
vi. Sending: + CR(Enter key)

4. Setup net assist tool:
a. PC connect with AP. Open the TCP server before the following settings:

i. IP address: PC host IP
ii. Host port: 5001
iii. Receive: HEX

Note
Close VPN if opened.

5.3 Start Testing
Power on the TIDA-010224 board. The serial tool receives a message as shown in Figure 5-1.

Figure 5-1. Board UART Output Start Page

1. Provisioning mode.

If there is no Wi-Fi AP connected, selecting ‘1’ makes the board enter into Hibernate (provisioning) mode for 
configuring AP SSID and Password into the demo board. Details are:

a. Input ‘1’ makes the board enter hibernate.
b. Select the video and which audio to use. It is preparing to play the video after wake-up from hibernate by 

the UART input. After the input is finished, the board enters into hibernate.

Figure 5-2. Select Video Stream Type via UART

How to Test Current and Startup Time www.ti.com
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c. Input ‘1’ again, wake up board for provisioning, as shown in Figure 5-3.

Figure 5-3. Provisioning Status Output via UART
d. Open “SimpleLink Wi-Fi Starter Pro” APP in cell phone.

Figure 5-4. “SimpleLink Wi-Fi Starter Pro” Configuration Processing
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e. Click the ‘blue marked’ button.
f. Select ‘mysimplexxx’.
g. Select your Wi-Fi AP.
h. Input password.
i. Click the ‘start configuration’ button and select ‘close’ to finish provisioning. UART print as shown in 

Figure 5-5.

Figure 5-5. Provisioning IP Address Acquired
j. After provisioning, power off/on to restart demo board again. All of test functions could be continued.

2. Hibernate mode.

This mode is for testing board current in hibernate, entering provisioning if there is no recognized Wi-Fi AP 
and watch video stream via APP. Details are:

After power on, input ‘1’ makes the board enter into hibernate mode. You can measure the current via 5 V 
power input connector. Typically, the current is about 20 µA.

When entering hibernate mode, any UART input wakes up the board and exits hibernate. Actually, UART 
input is similar with GPIO trigger input. This mode is quite similar with some applications that only need 
buttons or alarm inputs such as PIR input to wake up the system.

After waking up the board, it is ready to accept RTSP request. In this mode, you can run network stream 
APP to watch. As shown in Figure 5-6, click ‘+’ to add a new address, input rtsp address and port. For 
example, rtsp://192.168.0.103:554, choose UDP. Click ‘OK’(确定) to open video stream.

Figure 5-6. RTSP Configuration

How to Test Current and Startup Time www.ti.com
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Note
If measure current is in hibernate mode, make sure to disconnect with the JTAG cable and unplug 
the J1 jumper.

3. Intermittently Connected mode.

This mode is for the testing the board average current, which is intermittently sending status data to server 
and enters into hibernate. It is also woken up by any input via UART and entering into ready to accept RTSP 
request when it is in hibernate mode. Same as above, UART input is similar with the GPIO trigger input. This 
mode it is quite similar with some applications that report status and heartbeat signal to remote servers with 
long interval time. Details are:

a. After power on, input ‘2’ makes the board enter into intermittently connected mode.
b. Select video and which audio to use. It is preparing to play the video after wake-up from hibernate by the 

UART input.
c. Input remote TCP server IP address such as 192.168.10.105.
d. Input interval time in second such as 10.
e. Board is woken up intermittently by RTC and sends 100 data to remote TCP sever again and again.
f. Any UART input wakes up the board from hibernate to prepare accepting RTSP request mode.
g. UART tool Print:

Figure 5-7. UART Printing in Intermittently Mode
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h. Net assist tool Print:

Figure 5-8. Net Assist Receiver Printing in Intermittently Mode

In Net printing, a new connection is created every time. The connection is lost between sending data.

Note
TCP server must be opened before finished configuration. If don’t receive TCP data in server, 
please try to close VPN or add net assist software in white list of firewall software.

4. Always Connected with Long Sleep/with IOT mode.

This mode is for testing board average current that is intermittently sending status data to the server and 
entering into LPDS. In this mode, the network connection between the test board and the Wi-Fi AP is not 
lost. It is also woken up by any input via UART when it is in LPDS. This mode it is quite similar with some 
application that only report status and heartbeat signals to remote servers, and are able to respond to server 
requests quickly because the connection socket is not lost in the remote server.

Note
IOT and Long Sleep mode need AP supporting.

How to Test Current and Startup Time www.ti.com
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a. Details are:
i. After power on, input ‘3’ or ‘4’ will make board enter into Always Connected with Long Sleep or with 

IOT mode.
ii. Input beacon interval time to keep alive in AP connecting list.
iii. Select video and which audio from, it is preparing for play video after wake-up from hibernate by 

UART input.
iv. Input remote server IP address, such as 192.168.10.105.
v. Input interval time of sending data in second, such as 10.
vi. Board will be woken up intermittently by RTC and send 100 data to remote TCP sever again and 

again.
vii. Any UART input will wakeup board from hibernate to prepare accepting RTSP request mode.

b. UART tool print:

Figure 5-9. UART Printing in Always Connecting Mode
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c. Net assist tool print:

Figure 5-10. Net Assist Receiver Printing in Always Connecting Mode

In Net printing, A new connection is created firstly, and it isn’t lost between sending data.

Note
TCP server must be open before finished configuration. If you do not receive TCP data in your 
server, try to close VPN or add net assist software in white list of firewall software.

5. Measure Time of Key action.

This mode is for testing the board startup time that is from exiting hibernate to sending out the 10 frames of 
image. It is able to be woken up by any input via UART for testing. You can get the printing timestamp log via 
UART or test the wave via J13.2 pin with oscilloscope. Details are:

a. After power on, input ‘5’ makes the board enter into Measure Time of Key action mode.
b. Input remote server IP address such as 192.168.10.105. Then test board enters into Hibernate.
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c. Any input via UART wakes up board and send data out to remote TCP server after getting the image 
frame.

Figure 5-11. UART Printing in Measure Startup Mode
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Figure 5-12. Net Assist Receiver Printing in Measure Startup Mode

Note
The startup time is affected by WIFI connection time, especially in the first time running.
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